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Los SIG y ArcGIS

Los SIG (Sistemas de Informacion Geografica)

éQué es un SIG? (SIG: Sistema de Informacion Geografica/GIS: Geographic
Information System)

Es cualquier sistema de informacion capaz de integrar, almacenar, editar, analizar,
compartir y mostrar la informacion geograficamente referenciada. En un sentido mas
genérico, los SIG son herramientas que permiten a los usuarios crear consultas
interactivas, analizar la informacion espacial, editar datos, mapas y presentar los
resultados de todas estas operaciones.

Algunos conceptos basicos
La razén fundamental para utilizar un SIG es la gestion de informacion espacial.

El sistema permite separar la informacion en diferentes CAPAS (Layers) tematicas y las
almacena independientemente, permitiendo trabajar con ellas de manera rapida y
sencilla, y facilitando al profesional la posibilidad de relacionar la informacion existente
a través de la topologia de los objetos, con el fin de generar otra nueva que no
podriamos obtener de otra forma.
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llustracién 1. Fuente: http://www.aulati.net/?tag=bases-de-datos-geograficas
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Existen dos formas de almacenar los datos en un SIG: raster y vectorial.

RASTER: Cualquier tipo de imagen digital representada en mallas (PIXELS). Divide el
espacio en celdas regulares donde cada una de ellas representa un Unico valor.

Algunos formatos muy utilizados: jpeg, png, tiff..

-~
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-
-

llustracidn 2 Fuente: ESRI

Ejemplo: fotografias, ortoimagenes :

VECTORIAL: Aqui los datos estan basados en la representacion vectorial de la
componente espacial de los datos geograficos. Esta forma ..
de expresion espacial implica la utilizacion de los tres tipos @
de elementos espaciales, de caracter geométrico, en que
pueden ser interpretados los objetos geograficos: puntos, e
lineas y poligonos. Los atributos tematicos, que
corresponden a las unidades espaciales, se manejan,
habitualmente, desde tablas de datos.

® Lines

llustracién 3 Imagen vectorial: Puntos, lineas, poligono, texto Fuente: ESRI Polygons Annotation



http://es.wikipedia.org/wiki/Gr%C3%A1fico_rasterizado
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raster data
urban area

river

vector data

llustracidn 4. Diferencia Raster (arriba)/Vectorial (abajo)

VENTAJAS DE INFORMACION RASTER Y VECTORIAL

VENTAJAS RASTER VENTAJAS VECTORIAL

-Estructura de datos muy simple Elevada precision

-Facilidad para la representacion
de entidades espaciales
continuas.

- Elevada capacidad para la
superposicion y combinacion de Mapas de elevada calidad

capas

- Capacidad para la realizacion de Capacidad para realizar analisis de

Facilidad de integracién con CAD
vectoriales

analisis geoestadisticos redes

) Capa’CI_d ad para integrar datos Estructuras de datos con topologia
de satelite

- Cf:lpaCIdad de incorporacion de Ficheros de poco tamafio
imagenes

Tabla 1. Ventajas de informacion Raster y vectorial. Fuente: Elaboracion propia a partir de datos de ESRI

ArcGIS

« Programa informatico producido y comercializado por ESRI, que agrupa varias
aplicaciones para la captura, edicién, andlisis, tratamiento, disefio, publicacién e
impresion de informacidn geografica.

« ArcGIS Desktop, la familia de aplicaciones SIG de escritorio, es una de las
mas ampliamente utilizadas, incluyendo en sus Ultimas ediciones las
herramientas ArcReader, ArcMap, ArcCatalog, ArcToolbox, ArcScene y
ArcGlobe, ademas de diversas extensiones. ArcGIS Desktop se distribuye
comercialmente bajo tres niveles de licencias que son, en orden creciente de
funcionalidades (y coste): ArcView, ArcEditor y ArcInfo.



http://es.wikipedia.org/w/index.php?title=ArcGIS_Desktop&action=edit&redlink=1
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Mddulos de ArcGIS (Licencia ArcView - UAM)

ArcMap: Es la aplicacion central para visualizacion y manipulacién de datos
geograficos

ArcCatalog: Es la aplicacién que se utiliza para gestionar los archivos a
utilizar: mapas, bases de datos etc. Ayuda a organizar la informacidn geografica
y es imprescindible para mantener nuestros datos en orden.

ArcToolBox: Sirve para realizar operaciones de procesamiento de informacion
geografica: analisis de datos espaciales, conversion de formatos, gestiéon de
datos y muchas mas operaciones.

ArcScene: Permite visualizar datos en 3D
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llustracion 5. Médulo ArcMap Fuente: Elaboracién propia a partir del mapa 1:25.000 IGN



Busqueda de informacion Geografica en la red

En los siguientes ejercicios vamos a utilizar varias capas de informacién que vamos a
obtener de la red. En internet se pueden encontrar numerosos recursos cartograficos
(ver tutorial “Recursos Cartograficos en Internet” en la pagina web de la Cartoteca
Rafael Mas, en el apartado “Guias y Tutoriales” http://biblioteca.uam.es/cartoteca).

Obtencion de datos de la pagina web del
Instituto Geografico Nacional
www.ign.es

e £Enla pagina de inicio del IGN pinchamos en el boton "Descargas”

w B B B B
IR

http://centrodedescargas.cnig.es/CentroDescargas/index.jsp

Esto nos lleva al Centro de Descargas del IGN

Para poder descargar la informacidn es necesario registrarse en la pagina. Una vez
completado el registro e introduciendo nombre de usuario y contrasefia podremos
proceder a la descarga.

e Seleccionaremos el icono “"Descarga gratuita de informacion geogradfica
digital para uso no comercial”



http://biblioteca.uam.es/cartoteca
www.ign.es
www.ign.es
www.ign.es
http://centrodedescargas.cnig.es/CentroDescargas/index.jsp
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Presentacion del Centro de Descargas

Centro Nacional de I

Centro de Descargas
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] [Registrarse | [olvido contraseda |

Usuario | | contrasefia |
Presentacién | Catilogo de productos | Bisquedaenvisor | Bisqued da | de Necional | Ayuda |
. ]
s =) (0 O
Centro de Descargas/’ Bisqueda Avanzada
Busqueda Avanzada
Bisqueda Avanzada
Seleccione Productos Seleccione Divisibn administrativa: Seleccione Hoja del MTNSO:
Wapa Provincial 200 réster - [Provincia =]
Productos i
Mer cuadricula del MTNSO
BCN25-BTNZS [uanrD [=]

MTN2S réster

MTNSO raster

\lapa Provincial 200 réster

Modelo Digital del Terreno - MDT25
Medelo Digital de! Terreno - MDT200
Corine Land Cover

Ortofoto PHOA Waxima Actualidad
Ortofoto PNOA Méxima Resolucitn
MTNSO Histirico

MTN2S Histrico

Mapa Provincial 200 Histérico
Mapa Autondmico Historico
CartoCiudad

Mapa provincial 200 vectorial
MTNSO vectorial

MTN2S vectorial

BCN200

Ver lista de Productos

Ver documento de ayuda (pdf)
Ver video de ayuda (avil

wlag  WCETS v

sccesibilidad | Informacidn leqal | Propiedad intelectual | Proteccidn de datos

Sugerencias y
comentarios.

e £n el menu desplegable de productos seleccionaremos e/ Mapa Provincial

200 Raster y en el desplegable siguiente "Provincia” o "Comunidad Autonoma”

y "Madrid”. Después pinchamos en "Ver lista de productos”.

Nos aparece una pantalla que muestra el nombre y formato del archivo. Pinchamos en

el icono debajo de “Descargar” y Aceptamos la licencia.

pagina 1 de 1

Producto Archivo

Mapa Provincial 200 raster MADRID.zip

Formato
TIFF

Tamafio{MB|

11,4

scargar
E

pagina 1 de 1




Pasamos al punto siguiente y la descarga de datos comienza. Debemos localizar
dénde se ha descargado la carpeta y descomprimirla*.

e (Creamos una nueva carpeta (o bien en C: o en una memoria extraible) y la
llamamos por ejemplo SIG_EJERCICIOS

e Copiaremos los archivos descargados en nuestra nueva carpeta
"SIG_EJERCICIOS”.

En este caso, tendremos el mapa provincial de Madrid a escala 1:200.000 en formato
TIFF y un archivo con las coordenadas del mismo (que sirve para que el programa
ArcGIS lo ubique geograficamente).

*Nota: La carpeta descargada del IGN aparece comprimida. Para descomprimirla
necesitaremos un programa adecuado como WinZIP o WinRAR. Si lo tenemos instalado
basta con pulsar botdn derecho sobre la carpeta y pulsar en “Extraer en _(nombre
carpeta)”

Obtencion de datos de la pagina web del nomenclator de Ia
Comunidad de Madrid

http://www.madrid.org/nomecalles/

e Pinchamos en "Acceso a Nomecalles”

%) NOMECALLES Instituto de |E

Nomenclitor oficial y Callejero Estadistica

LaBuma o Torks | NS

en [Todals Comunidsd [w]

Por Ejemplo: Gran Via

‘ Que es / Actualizaciones / Ayuda

« Nomecalles es la difusin del Sistema de Informacidn Territorial del

Armuma CBHE: (Puzue\u de Alarcén) Instituto de Estadistica

Arnaldo de Villanova, Calle (Getafe)

Arnedillo, Calle (Madrid) « Pretende ser un sistema de informacidn, tanto de usuarios expertos
Arnadn_ralla (Madrid) como de no expertos, donde se retinen por un lado la informacidn

de delimitaciones geograficas. callejeros, fondos catastrales y
fotografias aéreas y, por otro la informacién puntual de interés

ArOsa, Lalle [Alcorcon) georreferenciada

Remebmcni Falla f0an 1 mrnnsn e U e e Al

COMIrossau sssss s
cementerios _ universidades teatros
ayuntamientos o _ gasolineras

l:plfi;;'esrmerca\dus Ieglos embals

troscomerciales

STAUUATAR TR e

hoteles =777 qudrderias

ORI Dircccion General I de Economia. En colsboracisn con
D ese o scion Toanclsgica
CONSEJERIA DE ECONOMIA Y HACIENDA B | 'c'

Comunidad de Madrid

e Nos aparece el visualizador y arriba pinchamos en "Descarga de Capas”

¢) NOMECALLES insttuto de P2
=¥ Nomenclitor oficig lejero

36696 %, Descarga oy Notificar p Mapas = y  Enalish
& ° = de capas %' un error . temdticos 5 Bxportar 7 Avuda B2 Contactar B version



http://www.madrid.org/nomecalles/
http://www.madrid.org/nomecalles/

e Dentro de "Delimitaciones Territoriales” seleccionamos las capas:

> "Barrios Madrid”
» "Municipios”

e Pinchamos en "Descargar Cortes”. A continuacion aparece una pantalla en la
qgue debemos decir para qué vamos a utilizar esta informacion.

=y - -
[ Administracion pitblica: Seguridad Social
[E] Calkero: Ees de viales

[E] Callefero: Nimeros de los viales

[E] Centros santtarios: Hospitales

[ Comereio: Centros comerciales

[E] Comercio: Galerias de aiimentacion

Descargar puntos

Delimitaciones Territoriales

[E] Proteccion y seguridad: Policia nacional [F] Transportes y comunicaciones: Intercambiadores

(=] [F] Transportes y comunicaciones: Linea AVE
Serv. cuturales, recreativos. y personales: Cines _
[F] Transportes y comunicaciones: Metro (bocas

Serv. culurales, recreativos y personales: Museos [T Transportes y comunicaciones: Metro (estaciones

[} [ Transportes y comunicaciones: Metro (ineas
Serv. culurales, recreativos y personales
parroguias

Seleccione los cortes que desee descargar. Los datos se encuentran en formato shp bajo la proyeccion EDS0
Para obtener un corte de un afio anterior al ditimo disponible, presione el icono situado a la derecha del nombre de cada corte. Pulse “Descargar cortes” para continuar

con la descarga

[ Areas de Salud 2
[ Areas de Servicios Sociales 2
[]Barrios Madrid 2

[ Codigos Postales =

[F] Demarcaciones de Servicios Sociales 2

[ Distritos 5
[ Distritos de Madrid

Descargar cortes.

Enlaces de interés relacionados:

[F] Distritos de Salud =
[F] Distritos de Servicios Sociales 5
[F]Entidades

[&] Municipios 2

[F] Nicieos 2 [F] Zonas Educativas 5
[F] Seccionado
[F] Sectores =& [ Zonas Metropoltanas 5

[F] Zonas de Salud 2
[F] Zonas de Servicios Sociales 2
[F] Zonas de Transporte 4

[F] Zonas Estadisticas 2

[F] Zonas Basicas de Salud del Area Unica 28

ol s m Callejeros I im Planocalle

Publicacion en tamafio A4 para cada uno de los municipios (Distritos en Madrid) que contiene sobre €l parcelario urbano los
g viales y los nimeros, acompafiados de informacion sobre infraestructura y delimitacion territorial. Incluye, para faciltar su uso
& un indice de localizacién de viales.

b p ¢ Farta haia del plann ralls e una riadrienl del ndetar minicinal 2 1A manar sarala v nar in fantn mavnr dstalis

Comienza la descarga de una carpeta comprimida en formato ZIP (la cual, al igual que
anteriormente, debemos descomprimir )

e Copiamos todos los archivos descargados en nuestra carpeta: SIG_EJERCICIOS

4.0 Favoritos
& Descargas
B Escritorio

1| Sitios recientes

4| - Bibliotecas
4 @ Documentos
=] Imagenes
P J’ Musica
4 E Videos

BARRIOS

> ¥ Grupo en el hogar

4l Equipo
b ﬁ Disco local (C)
s DATOS (E)
A INGSTON (G

MUNICIPIOS

Nombre . Fecha de modifica... Tipo Tamafio
__| 200001346.dbf 24/03/2011 12:06 Archivo DBF 22KB
__| 200001346.shp 10/03/2011 &:42 Archivo SHP 2144 KB
= 200001346.shx 10/03/2011 &:42 Archivo SHX 2KB
__| 200001370.dbf 24/03/2011 %16 Archivo DBF 10KB
| 200001370.shp 24/03/2011 %16 Archivo SHP T31KB
200001370.shx 24/03/2011 %16 Archivo SHX 2KB
__| MADRID_H30.TFW 30/06/2007 13:43 Archivo TFW 1KB
i MADRID H30 01/07/2007 11:38 Archivo TIF T1312KB

. SIG_EJERCICIOS

" st License (W150.244041) (Z3)

llustracion 6 . Vista de la carpeta SIG_EJERCICIOS en el explorador de Windows
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Como se puede observar en los archivos descargados, tenemos 3 ARCHIVOS de
MUNICIPIOS (.shp, .dbf, .shx), otros 3 ARCHIVOS de BARRIOS (.shp, .dbf, .shx), y 2
ARCHIVOS de MAPA provincial (.tiff, .tfw)

Shapefiles

En ArcGIS el formato de archivo vectorial mas usado es el .SHP (Shapefile).

Un Shapefile es un formato vectorial de almacenamiento digital donde se guarda la
localizacion de los elementos geograficos y los atributos asociados a ellos.

Un SHAPEFILE es generado por varios archivos. El nUmero minimo requerido es de
tres y tienen las extensiones siguientes:
* .shp - es el archivo que almacena las entidades geométricas de los objetos.
* .shx- es el archivo que almacena el indice de las entidades geométricas.
* .dbf - el dBASE o base de datos, es el archivo que almacena la informacién de los
atributos de los objetos (tabla de datos)

Ademas de estos tres archivos requeridos, opcionalmente se pueden utilizar otros para
mejorar el funcionamiento en las operaciones de consulta a la base de datos,

informacién sobre la proyeccién cartogréfica, o almacenamiento de metadatos. Estos
archivos son:

.sbn y .sbx - Almacena el indice espacial de las entidades

.fbn y .fbx - Almacena el indice espacial de las entidades para los shapefiles que son
inalterables (solo lectura)

.ain y .aih - Almacena el indice de atributo de los campos activos en una tabla o el
tema de la tabla de atributos.

.prj - Es el archivo que guarda la informacion referida a sistema de coordenadas.

.shp.xml - Almacena los metadatos del shapefile.

11



* Los ficheros que componen un shapefile (.shp)
pueden ser de distintos tipos:

PUNTOS

L |
n
| LiN EAS )

ArcCatalog

éPara qué utilizar el ArcCatalog?

Antes de empezar a elaborar nuestros mapas con ArcMap es conveniente que
manejemos el mddulo ArcCatalog, que sirve para organizar, administrar y visualizar la
informacién que vamos a utilizar.

ArcCatalog permite organizar carpetas, ficheros, bases de datos y servidores, y por
tanto es una herramienta fundamental para trabajar ordenadamente con
nuestros datos geograficos.

*  Abrir ArcCatalog:
- Inicio>Programas—>ArcGis—>ArcCatalog

- Icono ArcCatalog (en ArcMap)

12



Iniciar ArcCatalog y conectar la carpeta de ejercicios

File Edit View Go Tools Window Help

New »

£ QAHO =N

Yo .|

Vamos a afiadir la carpeta que hemos creado a nuestro menu
del catalogo para agilizar las busquedas de nuestra informacién
geografica.

Conterts | Preview | Metadata |

Name:  ArcWeb Services
Type:  AmcWeb Services Folder

. Ve @ e
e Para ello pinchamos en el boton e -
(8 Coordinate Systems
({9 Database Connections
() Datsbase Servers
(&) GIS Servers
A Search Results

"Connect to folder " o0 File=>Connect to £ 8 Toolbone
Folder.

LA CONEXION DE DIRECTORIOS

Esta funcionalidad se utiliza para acceder a discos externos, unidades de CD o
DVD, otros discos en la red de una institucion y conexiones a servidores WEB -

WMS

e Buscamos la carpeta recién creada "SIG_EJERCICIOS " y aceptamos.

Nos aparecera nuestra carpeta en el arbol desplegable del catalogo. Si hacemos
Doble Click sobre la carpeta podremos ver los archivos que se encuentran en ella.

File Edit View Go Tools Window Help

File Edit View Go Tools Window Help

=Y X mEES A @O N B B K 53 & @@ O3 W
Locaton:  [G\ Location: [G:\SIG_EJERCICIOS -]
Stylesheet:  [FGDC ESRI Syt [GOCESR 3]
© Cotalog 2| Comc| e e ——————— «[ Contents | Preview | Metadata|
Name [ Type § Catalog
7@ C\ Name | Type
[ fseventsd Folder i@
CACARTOGRAFIA &
i g C‘tUsers\CARTOTECA\Desk (1 Spotlight-v100 Folder (@ CACARTOGRAFIA ﬁggggﬁ;ﬁip i::pj::
CAUser\CARTOTECA Do | Trzshes Folder (@ CAUsers\CARTOTECA\Desk | g 2o l—‘BGFTIF . f Datasct
ig o e Rlle <ic jcreicios | Folder (@ C\Users\CARTOTECA\ Dot ke esterDatas
5@ B\ @ DA
o A @&
(@ G @F
] = G

{21 fseventsd

3 Spotlight-V100
{1 Trashes

{2 SIG_EJERCICIOS
(3@ ArcWeb Services

1.8 Coordinate Systems

- (£ Database Connections

{0 feventsd

{1 Spotlight-V100

[ Trashes

/23 SIG_EJERCICIOS

(2 ArcWeb Services
(& Coordinate Systems

1.(H Database Servers (&% Database Connections
788, GIS Servers ([ Database Servers
2§\ Search Results (), GIS Servers

- (¢ Toolboxes &\ Search Results

&1 (8 Toolboxes
llustracion 7 Vista de la carpeta SIG_EJERCICIOS utilizando ArcCatalog

Nota: Se puede ver en la carpeta de ejercicios utilizando el explorador de
Windows, que aparecen 8 archivos en total, mientras que en la vista con
ArcCatalog soélo aparecen tres. Esto es debido a que ArcCatalog agrupa los
distintos archivos que componen cada capa. Esta es una de las razones por las que
conviene gestionar los archivos desde ArcCatalog y no desde el explorador de
Windows. Por tanto cada vez que queramos renombrar capas, cambiarlas de

13



ubicacion, etc. es mejor utilizar ArcCatalog, que tratara todos los archivos de cada
capa conjuntamente evitando asi posibles errores.

Como vemos en el visor de Catalog, los archivos correspondientes a Municipios y a
Barrios aparecen con un cddigo numérico, que vamos a modificar para trabajar
mejor con el archivo.

Modlificacion de archivos con ArcCatalog y visualizacion previa

Dentro de ArcCatalog aparecen tres pestafias. Hemos utilizado la llamada
“Contents” que muestra los archivos existentes.

e Seleccionamos uno de los archivos y pinchamos en "Preview”

e aenw aane on

llustracion 8 Pestaiia “Preview” del ArcCatalog en la que se muestra la capa seleccionada (en este caso
Municipios de Madrid)

Sabiendo que el archivo seleccionado en este caso corresponde a la capa de Municipios
de Madrid, vamos a cambiarle el nombre para poder identificarla. Lo mismo haremos
con la capa de los barrios.

e Seleccionamos la capa y hacemos otro click encima para poder editar e/
nombre, y se lo cambiamos a "Municipios” o a "Barrios” segun corresponda.
(También podemos pinchar con el boton derecho sobre la capa y "Rename”)

14



i ArcCatalog - ArcView - GASIG_EJEF
File Edit View Go Tooks Windov
[ By X
Location:  [G\SIG_EJERCICIOSM200
Stylesheet: [FGDCESRI

&) Catalog
@
(@ C\CARTOGRAFIA
(@ C:\Users\CARTOTECA\Desk
(@ C:\Users\CARTOTECADoat
@0\
@BE
@F
@\
3 fseventsd
@3 .Spotlight-V100
{20 Trashes
£ SIG_EJERCICIOS
:
200001370 shp
@ MADRID_H30.TIF

T lacabbesesu g
® BITE £

Ahora tenemos los archivos bien nombrados para que resulte mas sencillo trabajar con
ellos. Si queremos cambiarlos de ubicacion es recomendable también hacerlo con
ArcCatalog, moviéndolos de una carpeta a otra.

ArcMap

Cargar capas de informacion geografica

e Vamos a abrir el ArcMap (Inicio> Programas—> ArcGIS> ArcMap) y una
vez abierto aceptamos la opcion "A new empty map > OK

@R Untitled - ArcMap - ArcView

File Edit View Bookmarks Insert Selection Tools Window Help

DEWS =) + AR =Ly
Editor ¥ - [ Create New Feature | [ =l
® x
a [=] Loyers|
e Q arcMap ===
Start using Archap with
@ Q)| & Ere s s
@ © Atemplate
Tempiates provide ready-to-use layouls and base maps for
warious gegraphic regions.
k %’ " An existing map:
b4 Browse for maps.
)
o ~
o &@
Py
&
™ Immediatety add data
I~ Do not show this dialog again
&l I™ Load last map on startup

Antes de empezar a trabajar es conveniente hacer un ajuste. Nos vamos a:

e File®> Document Properties-> Data Source Options-> “Store relative
path names to data sources” y "Make relative paths the default for
new map documents I create”



R Untitled - ArcMap - Arciew
File Edit View Bookmarks Insert Selecti
O New... CtrleN
= Open Ctrl+0
& save Ctrl+S
S ~tted Sopertes =]

Save A Copy.
<+ AddData...
Add Data From Resource Center...

-
(] Page and Print Setup... -
A

[& Print Preview...

& Pprint.

E

Importfrom ArcView project... - = . Data Source Options

Export Map...

In this map document. “
1 GAVARL.\PLANO_GUINDA.mxd

" Store full path names to data sources
2 G\mapa..\PLANO_GUINDA.mxd e e e

AE T e ] e I {* Stors relative path names to data sources I

4 G\mapa_g..\mapa_guinda.mxd -

5 G\Allendelallende mxd

Bxit Alt+F4 9 e 9

Make relative paths the defautt for new map documents | create

Este paso es IMPORTANTE si vamos a trabajar con una unidad extraible en distintos

ordenadores, ya que no tendra en cuenta la ruta completa del archivo sino la relativa,
de modo que podremos cambiar la ubicacién del archivo y el programa sera capaz de
cargar la informacion.

Vamos a cargar nuestras capas de datos ubicadas en la carpeta SIG_EJERCICIOS.

e Para ello pulsamos el boton "Add Data” (ver imagen) y seleccionamos la
carpeta. Seleccionamos los tres archivos de la carpeta y pinchamos en "Add”.

QR Untitled - ArcMap - Arcliew

File Edit View Bookmarks Insert Selection Tools Window Help

DS =] | e\

Editor ~ = [[Create New Festure: 1=l [ =1

@ x

o |[eEm

i Lookin: [G@ & e EEE
feeventsd

by} Spotlight- V100

@ Trashes

SI6_EIERCICIOS Ad Date ———

Ly

(i}

#“ Nare: [ i

s 6 | || Showoftype: [Dotosets ond Layer (i S e |

i, Unknown Spatial Reference (9 [

‘The following data sources you added are missing spatial reference
infomation. This data can be crawn in ArcMap, but cannct be projected.

Barrios
MADRID_H30.TIF
Municipios

Nos aparece un mensaje de error porque las capas no tienen
asignado un sistema de referencia (lo solucionaremos después). Pinchamos OK.
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Podemos ver en la imagen siguente las tres capas cargadas. En la parte izquierda de la
ventana aparecen las capas. Se pueden mover de arriba abajo, con lo que cambiara la
visualizacion de las mismas. La capa situada en primera posicion serda la que se
visualice por encima de las demas. Si probamos a activar y desactivar cada capa
vemos cdmo aparece y desaparece de la vista de mapa.

- — - — ol =D

File Edit ;_/wew Eoc;kmavks Insert Selection Tools Window Help I
e BARRA DE MENUS

Editor = ~ [ Create New Feature | chAl =1 Georeferencing ~ | Layer: [MADRID_Ha0 TIF ERCRArS
- AT,

K]
@ | -DATA FRAME

=28

x

¢ [CAPAS (Lavers)
]

k

i)

BARRA DE HERRAMIENTAS

VISTA DE DATG!
(DATA VIEW)

Display | Source | Seledtion op EROT| L

Drawing ~ K O~ A~ @) Aval 0 - Bz U A DS -~

VISTA FINAL DEL MAPA
(LAYOUT VIEW)

Utilizando la barra de herramientas podemos acceder a las mas habituales, como son
el zoom, la herramienta mover, herramientas de seleccion, busqueda, etc.

Asignar un sistema de referencia a nuestros datos geograficos

En numerosas ocasiones es hecesario asignar un sistema de referencia a nuestros
datos geograficos. Algunas veces las capas ya llevan asignado el sistema de referencia,
por lo que no se hace necesario realizar este paso. Aun asi, es importante saber que
todas las capas que carguemos han de estar en el mismo sistema de referencia si
queremos que tenga sentido el mapa que vamos a crear.

Como podemos observar en nuestro proyecto de ArcGis, en la parte de abajo a la
derecha nos aparece la siguiente informacion:
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| 484881,654 4463485846 Unknown Units

Esto se debe solucionar de la siguiente manera, para este ejemplo:

e View~- Data Frame Properties—> Select a coordinate system:
Predefined->Projected Coordinate System—>UTM-> Other GCS->
ETRS_89_UTM_Zone30N

. 1
Data Frame Properties [

Annotation Groups Edent Rectangles | Fame |  Sizeand Poson |
General | Dataframe  Coordinate System | lluminatin | Grids | Map Cache

Current coordinate system:

Unknown - Clear

|View Bookmarks Insert Selectic Note: one or more |ayers is missing spatial

reference information. Data from these layers
| @ Data View

cannot be projected.
1 Layout View

Zoom Data » i

Zoom Layout » 4 b Transformations. ..

\ Select 3 coordinate system:

Toolbars » b Eaiaiis Moy, . |
(] Predefined ]
|T Status Bar T v Impart...
2423 <custom>
Overflow Annotation ] Uinknown - |

Add To Favorites
Remove From Favorites

E Scrollbars

jsy| Data Frame Properties... 9 Cancelar | Apican 9
-
Data Frame Properties M

Annotation Groups I BExtent Rectangles I Frame I Size and Position I
General Data Frame ~ Coordinate System | llumination I Grids I Map Cache

Current coordinate system:

ETRS_1989_LITM_Zone_30N - Clear |
Projection: Transverse_Mercator

False_Easting: 500000,000000

False_Morthing: 0,000000

Central_Meridian: -3,000000

Scale_Factor: 0,999600

Latitude_OF_Origin: 0,000000

Linear Unit: Meter

GCS_ETRS_1989
Datum: D_ETRS_1389

-

4 3 Transformations... |

Select a coordinate system:

..... 5 ETRS 1989 UTM Zone 26N - Modify... |
..... i ETRS 1989 UTM Zone 27N

..... i ETRS 1989 UTM Zone 28N Import... |
..... T ETRS 1983 UTM Zone 23N M

----- s 1955 Ui zone o M

----- T ETRS 1989 UTM Zone 31N i
..... i ETRS 1989 UTM Zone 32N

----- i ETRS 1989 UTM Zone 33N Add Ta Favorites |

----- i ETRS 1989 UTM Zone 34N
""" @ ETRS 1989 UTM Zone 35N Remaove From Favorites |
----- T ETRS 1989 UTM Zone 36N -

< [ | +

Aceptar Cancelar | Aplicar |




Dependera de cada lugar el que elijamos una proyeccion u otra. En concreto, para
Madrid, el sistema ETRS 1989 UTM Zona 30N es uno de los mas habituales.

450390,192 4499355 231 Meters

Ahora en los datos que aparecen abajo a la derecha ya aparece la

unidad de medida Metros y las coordenadas de cada punto (que 5 e

iran cambiando a medida que movemos el ratén por nuestro e
mapa).

Copy
NOTA: Si en la ventana de visualizacién de mapa no aparece ?22“:
ninguna imagen, podemos seleccionar las tres capas - bot6n B
derecho - ZOOM TO LAYERS. Eso hara que aparezcan todas las W zoom To Loy |

Visible S5cale Range  »

capas en la vista y podamos comprobar si estan bien ubicadas
geograficamente.

Solucion de problemas con las proyecciones

Hemos asignado un sistema de referencia a nuestro proyecto, pero debemos tener en
cuenta que cada capa que utilizamos se ha podido crear en otro sistema de referencia
distinto, de manera que es habitual que haya que realizar ciertas conversiones para
poder trabajar correctamente con la informacidn geografica.

Hemos descargado varias capas del servidor de la Comunidad de Madrid Nomecalles ,
donde en la misma pagina nos especifica que esta proyectado utilizando el Datum
ED50.

Delimitaciones Territoriales

Seleccione los cortes gue desee descargar. Los datos se encuentran en formato shp bajo la proyeccion EDS0.

Para obtener un corte de un afio anterior al (timo disponible, presione el icono situado a la derecha del nombre de cada corte. Pulse "Descargar cortes” para continuar
con la descarga.

Sin embargo, las capas descargadas del IGN suelen estar proyectadas en ETRS89
debido al cambio de Datum oficial segun dicta el Real Decreto 1071/2007, de 27 de
julio (por el que se regula el sistema geodésico de referencia oficial en Espafa. Se
abandona ED50 y ETRS89 pasa a ser el nuevo sistema de referencia oficial).

Por tanto tenemos varias capas, unas proyectadas en ED50 y otras en ETRS89. Este es
un problema frecuente que es conveniente solucionar antes de seguir
trabajando.

Vamos a intentar solucionarlo de la siguiente manera: a

e Abrimos ArcToolBox (desde ArcMap o desde ArcCatalog). Si no aparece
pinchamos en Window—> ArcToolBox
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File Edit View Bookmarks Insert Selection Tools Window Help

[l = = = B ) & [[172983 BN =Y
Editor ~ < [ Creste New Feature | [ |

x

EY=] Localizador] g f£8 ArcToolbox

= B Barrios 2 @ Analysis Tools

x

[} HH & Cartography Toals
= B Municipios £ | | @@ Conversion Tools
[} m | (e & Data Management Tools
MADRID_H30.TIF & Dats Comparison
® w1 & Database
- w1 & Domains
w1 & Feature Class
@ w1 & Features

- Fields
& File Geodatabase

[ Y & General
o & Generalization
&y Indexes

] & loins
= & Layers and Table Views | @@
& =& Projections and Transform

& Feature

& Raster

i/ Create Custom Geogra
&l i A Define Projection

&y Raster

&y Subtypes

& Table

& Workspace

1. Geocoding Tools
. Linear Referencing Tools
1.8 Mobile Tools

. Multidimension Tools
. Samples

7 @ Schematics Tools
71§ Server Tools

1 & Spatial Statistics Toals

< B

_Display | Souros | Selection Favortes [ Index | Search | Resuks
Drawing ~| & O~ A~ 0] Aval [0 -] B 1 u A~

e ArcToolBox—> Data Management Tools—> Projections and
Transformations> Define Projection

Vamos a recordarle a las capas del Nomecalles la proyeccion que se supone que llevan,
la ED50, para posteriormente reproyectarla a la ETRS89.

e Input Dataset Feature Class: Barrios
e (Coordinate System. Select> Projected Coordinate Systems>UTM-> Other
GCS->European Datum 1950 30N> Add—> Aceptar
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#* Define Projection

S esp speue nerence rioperues
Input Dataset or Feature Class XY Coordinats System | Z Coordiate System
[Barrios KN e [Unknown
Coordinate System
[ Unknown Details:
Select Select a predefined coordinate system
Impert 2 coordinate system and X/Y, Z and M
Import... | domains from an existing geodataset (5.0 .
featurs dataset, feature class, raster.
ok | cancel | Environments... | showrep >> | New | Create a new coordinate system.

rermeFroTeCT
Browse for Coordinate System

laster

ubtypes - =
it okin: 2] Other GCS oo 2 &
Vorkspace il European Datum 1950 UTM Zone 30N.prj ) Fahud UTM Zone 39N.pg
“oding Tools ) European Datum 1950 UTM Zone 31N.prj 1 Fahud UTH Zane 40N.pi

) European Datum 1950 UTM Zone 32M.prj
) European Datum 1950 UTM Zone 33M.prj

European Datum 1950 UTM Zone 24N.prj
) European Datum 1950 UTM Zone 35N.prj

ar Referencing Tog]
ile Tools
idimension Tools

ples
\matics Tools ) European Datum 1950 UTM Zone 36M.prj
< Tools % European Datum 1950 UTM Zone 37N.prj

) Statitice Toole | | [ 72 Eurepean Datum 1950 UTM Zone 38N.py

{{Fatu va 1972 UTM Zone 7S.pj
{FD 1954 UTM Zone 29M.prj
{Fiji 1056 UTM Zone 15.prj

0 Fiji 1956 UTM Zone 605.prj

¥ Fort Desaix UTM Zone 20M.prj
{2 Fort Marigot UTM Zone 20M.pij
1 Garoua UTM Zone 33N.prj

Edi the propeties of the curertly selected
coordinate system

Setsthe coordinate system to Linknown
Save the coordinats system to a e

Aeeptar Cancelar

4

*
i |European Datum 1950 UTM Zone 30N prj

Show oftype: [Coodrate Systems =] Caodl

De este modo le hemos asignado el ED50. Vemos que ahora quedan descuadradas las
dos capas (Barrios y Municipios)

e Repetimos el proceso anterfor para las capas "Municipios” y
"MADRID_ H30.TIFF” (secleccionando también la misma proyeccion:
European Datum 1950 30N)

Ahora vamos a REPROYECTAR LAS CAPAS, para cambiar de ED50 al ETRS89

e Abrimos ArcToolBox—>Data Management Tools> Projections and
transformations-> Feature (capa vectorial)> Project
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@ ArcToolbox

[]--a Analysis Tools

- & Cartography Tools
(- &P Conversion Tools

[—]& Data Management Tools
[]—-& Data Comparison
]--& Database

]--& Domains

£

£

[]--& Feature Class
[]—-& Features

(- Fields

[]--& File Geodatabase
[]--& General

[]—-& Generalization
[]--& Indexes

[]--& Joins

[]--% Layers and Table Views
[—]—-& Prajections and Transform
E& Feature

2 Batch Project

: #° Create Spatial Refer

& Raster

----- #* Create Custom Geogra
i # Define Projection
[]—-& Raster

B85 Subtypes

-5 Table

[]--% Workspace

-8B Geocoding Taols

[]--a Linear Referencing Tools
[]--& Maobile Tools

[]--a Multidimension Tools

[

[

E

[

& Samples

]--% Schematics Tools
]--& Server Tools

]--a Spatial Statistics Tools

Project =8 = Spatial Reference Properties v =
] p
Wl | InputDataset or Feature Class = XY Coordrate System | 2 Coordinate System |
M| [Barrios =] &
¥ Name: [Urknown
k Detais:
aD Output Dataset or Feature Class
q | G:\s16_EERCICIOS \Barrios_Project.shp &
of | & Ouput Coordinate System
Al T E
¢ | Geooraphic (optioral)
Al |
g #
‘ X
g Select. Select a predefined coordinate system
[l
Impo ayetem and X/Y, Zand M
A M dom: ing geodaizsel {6 9.,
& ) Featur re olass, racter,
o Cancel | Environmen ... | ShowHelp>> | New +| Create anew coondinate system.
Edt the propertes of the currently selected
5 g —— J' J 1 coordinate system.
aster "
A Create Custd Browse for Coordinate System == Solerrrer e iy
#* Define Proje]
Raster Lookin: | Other GCS M) Save the coordinate system to a file.
_Sr“z‘m’“ ETRF 1989 UTM Zone 37N.prj HETRS 1989 UTM Z
=2 V¥ ETRF 1989 UTM Zone 38N.prj ETRS 1989 UTM Z:
Workspace B4 ETRS 1989 UTM Zone 26N.prj ETRS 1989 UTM Zone 35N.prj
peeding Tools | | 25 ETRS 1980 UTM Zone 27N.prj ETRS 1989 UTM Zane 36N.prj
sar Referencing | | %} ETRS 1989 UTM Zone 28N.prj ETRS 1989 UTM Zone 37N.pg
bile Tools i) ETRS 1989 UTM Zone 38M.prj
ticimension Tollf [z

s | | [{BETRS 1988 UTM Zone 32N.prj

e
tial Statistics T

«
Name: [ETRS 1389 UTM Zone 30N.pr

ETRS 1089 UTM Zone 30N.prj
@ European Datum 1850 UTM Zon:
1 European Datum 1950 UTM Zon:

Show of type:  [Coordinate Systems

e Input Dataset or Feature Class.: Barrios

e Output Dataset: aqui aparece el nombre que tendra la nueva capa

e Qutput Coordinate System: Select=> Projected> UTM—=> Other GCS> ETRS
1989 UTM Zone 30N> Add-> Aceptar

e Geographic Transformation: ED50 to ETRS89 12> OK

Nos aparece una nueva capa que cargamos en el proyecto y se llama

Barrios_Proyect

e Repetimos el proceso con la capa Municipios.

e Repetimos también con la capa "MADRID_H30.TIFF”, pero en ArcToolBox
hay que seleccionar la opcion Raster (en lugar de Feature, ya que TIFF es un
formato Raster) > Project Raster

NOTA: Cada vez que reproyectamos crea una nueva capa, hormalmente con el mismo
nombre_Project. Para no tener demasiadas capas y complicarnos es recomendable
borrar las capas anteriores y quedarnos sélo con las nuevas (Barrios_Project,

Municipios_Project y MadridH30ProjectRaster). Después podemos cambiar el nombre al

archivo desde ArcCatalog para que sea mas sencillo.
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Manejo de las herramientas mas habituales de ArcMap para la

exploracion de los datos

Las herramientas ZOOM, FULL EXTENT y PAN son las mas usadas para moverse
por el mapa. Es conveniente familiarizarse con ellas antes de seguir avanzando.
(También se puede utilizar la rueda del ratdn para realizar la funcién de ZOOM).

Centrar la vista en una capa

e Vamos a seleccionar la capa "Barrios” > Boton derecho> ZOOM TO LAYER.
Esto harad que la escala se ajuste para que aparezca en toda la imagen la capa

completa.

@ Untitled - ArcMap - ArcView

File Edit View Bookmarks Insert Selection Tools Window H
= = = @ - & |[1728888

Editor ~ e

=
=
2
2
=

°

I
= BT
o B2 copy

= B Municipios * Bemove

] Open Attribute Table
MADRID_H
Joins and Relates »

P& Zoom To Layer

Visible Scale Range 3
Use Symbol Levels
Selection »

Label Features

ZF Convert Features to Graphics...

Data

-

Save As Layer File..

Propertjes...

Metadatos de cada capa

Vamos a explorar la capa “"Barrios” para ver la tabla de
datos asociada.

e Seleccionar "Barrios”> Boton Derecho->
Open Attribute Table

La capa Barrios es una capa de tipo VECTORIAL
formada por POLIGONOS, y con una tabla de datos
asociada que consta de varios campos.

o i RN ONC

i T @

#

@ Untitled - ArcMap - ArcView

File Edit View Bookmarks Insert Selection Tools Window

e ld& B o & |[1178382
Editor ¥ < Create New Feature
x
®
B £F layers ‘ a
=¥ By

] Copy
2 @ Mur % Remove

O Open Attribute Table
MAL

Joins and Relates »

& Zoom To Layer

Visible Scale Range »
Use Symbol Levels
Selection 3

Label Features

Z# Convert Features to Graphics...

Data 3
Save As Layer File...

Properties...
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Attributes of Barrios

\=l= &) E| campo FID nos indica el orden de

“ | creacion de cada campo. Es un campo que

se crea por defecto. El campo SHAPE se

refiere al tipo de capa vectorial (PUNTOS,

mn

LINEAS O POLIGONOS). Los demés

campos son de creacidn propia y se les

puede cambiar el nombre, asi como crear

columnas nuevas para anadir nuevos datos

que podamos usar para crear nuestro

mapa.

Sha CODBDT | GEQCODIGO DESBDT
» Polygon | 679443 | 079011 Palacio
1| Polygon | 679444 | 079012 Embajadores
2 | Polygon 579445 | 079013 Cortes
3 | Polygon | 679446 | 079014 Justicia
4 | Polygon 879447 | 078015 Universidad
5 | Polygon 879448 | 079016 Sol
8 | Polygon 879445 | 075021 Imperial
7 | Polygon 879450 | 078022 Las Acacias
8 | Polygon | 879451 | 079023 La Chopera
8 | Polygon | 879452 | 075024 Legazpi
10 | Pobygon 5759453 | 075025 Delicias
11 | Pobygon 579454 | 075026 Palos de Moguer —
12 | Polygon | 679455 | 075027 Atocha
13 | Polygon | 679456 | 075031 Pacifico
14 | Polygon | 679457 | 079032 Adelfas
15 | Polygon | 679458 | 079033 Estrella
16 | Polygon | 679459 | 079034 lpiza
17 | Polygon | 679480 | 075035 Jeronimos
18 | Polygon | 679461 | 079036 Nifio Jesis
19 | Polygon | 679462 | 075041 Recoletos
20 | Polygon 679453 | 079042 Goya
21 | Polygon | 679484 | 079043 Fuente del Berro
22 | Polygon | 679485 | 078044 Guindalera
23 | Polygon 679466 | 079045 Lista
24 | Polygon | B79487 | 078046 Castelana
25 | Polygon 679468 | 079051 El Viso
26 | Polygon | 679458 | 078052 Prosperidad
27 | Polygon | 679470 | 078053 Ciudad Jardin
28 | Polygon | 679471 | 079054 Higpanoamérica
29 | Polygon | 679472 | 079055 Nueva Espafia
30 | Polygon 679473 | 079056 Castilla
31 | Polygon 679474 | 079061 Bellas Vistas
32 | Polygon 879475 | 079062 Cuatro Caminos
|_| 33| Polygon 679476 | 079063 Castillejos.
34 | Polygon 879477 | 075084 Almenara
|_| 35 |Polygon | 679478 | 079085 aldeacederas
|_| 36 |Polygon | 679475 | 075086 Berruguete
37 | Polygon 879480 | 079071 Gaztambide
[ | 38| Polygon | 679431 | 079072 Arapiles

nes i 1

;hcw: W Selected Records {Oj

Seleccion de campos

Si seleccionamos uno de los barrios en la tabla vemos que también aparece
seleccionado en el mapa. Esto nos sirve para ubicar cada poligono pero también
podremos realizar capas nuevas a partir de esa selecciéon (también podemos
seleccionar varias al mismo tiempo).

Se puede quitar la seleccién con el botdn

M

CEEEENENENENEEEEE NN

TITTTTTTITTTryTY
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@R Untitled - ArcMap - ArcView
Eile Edit View Bookmarks Insert Selection Iools Window Help

DEEE  BRX =~ &mrm [ 4a&ag0: . , .
e Sicon el poligono seleccionado vamos a la

Editor = - [ Creste New Feature =1
e 15 capa Barrios> Boton dcho>Data> Export Data
o y elegimos nuestra carpeta de trabajo, nos guardara

=

o @ m X Bemove
una capa nueva solo del barrio seleccionado

[ [ Open Attribute Tabl

IT

M Joins and Relates » Attributes of Barrios
& ZoomTetag ekt (deberemos asignar un nombre a la capa)

Visible Scale Range

Use Symbol Levels

Selection

Label Features

gon
gon
@ | 32 || Saving Data

L} - Export Data -
2on 5 Lookin: [ SIG_EJERCICIOS RS

BB EEE B 2BEEE
15
E

2 Convert Features to Graphics...

o Expart:  [Selected features
Barrios.shp

|_teotea ]} s he came coortinate system o Municipios.shp

Save As Layer File.
¢ this layer's source data

Properties.
View Metadata... " the data frame

[

T
2¢ [ Polvaon | €794 Output shapefile or feature dass:

‘C \Users\CARTOTECA\AppData‘Local' Temp\BamoGuindaleraut shy g

Name: |BamoGuindalerLt shp
| Cancel

|
| Saveastype: [shapelic

oK Cancel

Si cargamos esa nueva capa en nuestro proyecto y hacemos ZOOM sobre la misma,
nos quedaria algo parecido a esto (dependiendo del barrio elegido):

@ Uit - archiap - ArcViem ¥ - - [ i
Fie 6t ton Bookmarks It Selection Toos Wndow Hel
DFEES @ v oo | g |[FAET BT =131
e = - ] [ ] Geowterencng = | e DR FOTF =] (v 4@
= B
— a ]
=@ o
5 Barioe =
el |
5 @ Musiipor
Mg * |
B MADHID_HIOTIF - |
|
(] f
®
* 1
[
'y ]
& |
= |
—
2 |
1

Dty [Soce | Seecton| |

25



e Podemos quitar la seleccion de la capa utilizando la herramienta “Clear
Selected Features”

[P Select Features

Clear Selected Features
Guardar el proyecto

Para no perder los cambios realizados debemos guardar nuestro proyecto de ArcGIS. El
formato por defecto de ArcMap es .mxd.

e Archivo> Guardar Como-> SIG_cursobasico

a Guardar como ﬁ
Guardaren: [ | SIG_EJERCICIOS -~ ok E-
= Mombre . Fecha de modifica... Tipo
ey —
Sm:;g;; ee | JSIG_cursobasico 11/10/20111301  ESRI Arch
Escritorio
Bibliotecas
Equipo
@
Red
I I v
Normbre =] [ o
Tipo: [ArcMap Document ~| Cancelar

NOTA: es importante que tanto en las capas como en el nombre no aparezcan ni
espacios, ni signos de acentuacion, etc. para evitar posibles errores. Es recomendable
que los espacios se sustituyan por guiones bajos (_) y que no creemos nombres muy
largos para las capas (especialmente las raster).

NOTA UBICACION PROYECTO: A la hora de elegir la carpeta del proyecto, es MUY
IMPORTANTE que si trabajamos con una memoria extraible esté tanto el proyecto
como todas las capas que aparecen en él también en la memoria extraible, y lo mismo
si trabajamos en C. Si queremos pasar un proyecto de una ubicacién a otra (por
ejemplo de C: a una memoria extraible) lo mejor es que copiemos las capas utilizando
ArcCatalog y abramos el proyecto para guardarlo en la nueva ubicacidn, actualizando
las capas perdidas. Es muy comun que se intente copiar y pegar de una unidad a otra
y esto genere problemas.
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Propiedades de las capas

Vamos a trabajar con la capa “"Barrios”

e Desactivamos el resto de las capas, pulsamos boton derecho sobre esta capa y
seleccionamos "Zoom to layer” (para que nos aparezca toda la capa en la
vista del mapa).

e Volvemos a pulsar botén derecho sobre la capa “Barrios” y seleccionamos
“Properties” (0 mas sencillo, hacemos doble click sobre la capa). Aparecera
un cuadro con las distintas propiedades que tiene esa capa.

File Edit View Bookmarks Insert Selection Tools Window Hel

DeESE i} & |[7E3ez
Editor « - Create New Feature

| @
B £ layers Q
= O BarrioGuindalera
e
[ e
. ) = pe— -l
1 =& Copy
1 General i i
2 O Muni X Remove | Source | Selection | Display | Symbelogy | Fields | Defintion Guery | Labels | Joins & Relates | HTML Popup |
O EAD Open Attribute Table Layer Name: Barrios] ledie
Joins and Relates 3 Description: -
<& Zoom To Layer
Visible Scale Range » F ‘
redits:
Use Symbol Levels
Scale Range
Selection »
I You can spedfy the range of scales at which this layer will be shown:
Label Features pE (5 Show layer at all scales
" Don't show layer when zoomed:
i
2 Convert Features te Graphics... Outbeyond: |<Nons> (minimum scale) d :
In beyond: |<None> (maximum scale)
Data > @ ,%Lg’i
Save As Layer File...
3p| Properties...
e | _concstr |

Transparencia de capas

En la pestafia Display aparece la opcidn necesaria para dar transparencia a una capa,
donde podemos editar el porcentaje de transparencia (0%- capa opaca 100%- capa
transparente)
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7 [ |

GEHEIE” Snurce] Selection Display Symhn\ogy] Fields ] Definition Quarﬂ Lahels] Joins & Relates | HTML Popup I

Layer Properties

r
[¥ Scale symbols when a reference scale is set
Transparent: 50 5%

Hyperiinks
™ Support Hyperlinks using field:

[none 1|
(o ol @] [—

Feature Exclusion
The following features are excluded from drawing:

Feature ID__| GEOCODIGO |

Aceptar Cancelar

Simbologias de capa

En la pestafia “Simbology” vamos a poder cambiar los colores de cada capa. Si esta
seleccionada la opcién de la izquierda “Single Symbol” asignara el mismo color o trama

para toda la capa.

P[] |
General | Source | Selection | Display Symbology I Fields | Definition Query | Labels | Joins & Relates | HTML Popup |
Show:

p— Draw all features using the same symbol . Import..

‘ Symbl

Categories
Quantities
= |:| e

Multiple Attributes

Layer Properties

Legend

Label appearing next to the symbaol in table of contents:

\QL'\:'@" ,".v% Description

Q Additional description appearing e to the symbol in your map’s lsgend

Aosptar_|  Cancelar_| |

e Vamos a seleccionar la segunda opcion "Categories” y dentro de esta la
opcion "Unique Values”. En el campo Value Field seleccionamos el campo
DESBDT (que si nos fijamos en la tabla de datos asociada a esa capa vemos
que es el campo que corresponde al nombre de cada barrio).

Con esto conseguiremos que en la capa aparezca un color distinto para cada
barrio. Conviene fijarse en la tabla de datos para ver qué campo nos interesa para
hacer la simbologia mas adecuada.
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-
Layer Properties

Eenerall Sourcel Seled.icnl Display Symbology |Fields | Definition Gueryl Labelsl Joins & Relate

ies using unigue values of one field.

- Unique values, many
‘... Match to symbols in
Quantities T
Charts
Multiple Attributes

L) T

e

Show:
Features |m“
o m Value Field
ellniguc alugs | [cODBDT

Add Al Values I Add Values.

CODEDT

Color Ramp —
Elfley v 5
¥

| Count

bel
<all other values>

Remove | Remaove All |_M

|

Pulsamos Add All Values y apareceran en la lista todos los barrios con el color

correspondiente a cada uno. En el campo “Color Ramp” podemos elegir otra
paleta de colores, y también es posible editar los colores uno a uno.

Nos quedaria algo parecido a esto:

@ Saeursobasicn « Archla - ArcView @)
Fie £t Yow Bovkmarks e Selection Tocis Window Heln
DEES : b@x o~ 8w < ee0nwe
G| P | = Tos [Coate NowFosre g I o ERsIE-IE] P T s N ORI - |
a @ ol
= O BamoGuindaler ﬁ “
I =
= 2 2N U
5 <l ther values> .
DESBOT o o
bt L
[ Adetes LN
[Ey— e =
5 Ml de Osas w ¢
8 Admageo -
3 Amenars 2 -
5 Admendiies: y &
N duche o =
[ . —
Ammposta Liyecbropenes B
3 Apésto Sarsingn
9 Avapiles (Genera | Sowos | Selecton | Dspiay Smbology | Febds | Defraion Cuery | Labais | Jons & Reiates | HTML Popus |
" S
2;’::: —— ane fickd. ot
s s Vi ol
Ui DESEDT 5 5
B = TinmmEs 57
el Vit oot [t [voue Tiwst Tooms -
Dberuce ey I P e P e T |
E Bunavita M sipic recuses Pl DESEOT ]
3 B s !
= Compamenta Py Joetes | 1
I Canilas R Hameda de Ora 1
- i 3
1
[y
s - -
A | Ve e | RemoveM | Advagoed -
hemtar | Corcsor | ot
=l
an of

el
s faw E s msu A e g e
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Ejercicio simbologia

Vamos a crear un mapa de Madrid para localizar nuestro barrio, que posteriormente
utilizaremos como mapa localizador.

e (Centramos la vista en la capa "Municipios” y desactivamos la capa
"MADRID_ H30.TIFF”

e Cambiamos el color a la capa "Municipios” pulsando doble click sobre esta.
Seleccionamos la pestana "Simbology” y elegimos el color GRIS.

Symibal Selector CARES

yer Pre B ?
Layer Properties e [ S Freiew

General | Source | Selection | Display Symbology | Fields | Defintion Query | Labels | Joins & Relates | HTML Popup |
Show =
Femtres — Draw all features using the: same symbol Import 1
Single symbol 3
Cotomnaee Symbal Green Blue
Quantities |:| Advanced - Options
Charts
Multiple: Attributes oy -
Legend l:‘ No Color
Outine Width
Sun Holow
Label appearing next to the symbol in table of cortents e
L] EEEN
L] EEEN
N | o O
e AEEEEEEEEEEN
Addional descripiion appearing next to the symbolin your map's legend . n
Gray 50%)
prne
L] EEEN
Moo gEEEEEEE NN
D D s | More Colors...
Aceptar | Canestar Beige Yelow i -“ Cancel H

Ahora queremos que los barrios de Madrid aparezcan en color verde y que el barrio
que elijamos aparezca en rojo.

Eso se puede hacer de dos maneras:

a) creamos una capa de un solo barrio (como se hizo anteriormente) y a esa capa le
damos un color y a la capa Barrios otro distinto
b) bien utilizamos la capa Barrios y seleccionamos que nos dé la simbologia por
Categorias, utilizando el campo DESBDT y después cambiando el color al barrio
elegido.
e Flegimos la primera opcion
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|

E

PN
m

e Vamos a cambiar e/ nombre a nuestro “"Data Frame*” | Eie Edit view Bookmarks Insert e
llamado “"Layers” (arriba a la izquierda) por “Localizador” D& =X |-
para diferenciarlo del otro mapa que vamos a realizar. Para | ditor +| * | # = Toski [Createn
cambiar el nombre basta con seleccionar el Data Frame Layers

; . . & & Localizador] |
y volver a hacer click hasta que nos deje editario. 5 @ BarioGuindslera
||
. = Barrios
(*: Recordamos que Data Frame se refiere a nuestro marco de datos =
s . . Municipios
donde se situan las diferentes capas. Estas se pueden organizar y e
crear varios Data Frames que formaran nuestro mapa final. Por tanto H MADRIDH30.TIF

todos los distintos mapas que formaran el mapa final (localizadores,
mapa principal, etc.) estaran dentro de un mismo proyecto y cada uno tendra tantas
capas como queramos.)

De este modo en el mismo proyecto tendremos dos mapas, uno en grande con buen
detalle de la zona y otro pequefio como localizador.

e (Creamos un nuevo "Data Frame”: INSERT->DATA FRAME . Renombramos e/
Data Frame y le llamamos "Mapa”.

Ahora tenemos un nuevo Data Frame donde podremos afiadir otras capas. Los dos
(Localizador y Mapa) son totalmente independientes y se trataran

J File Edit View Bookmarks‘lnsert Selection Tools

como dos mapas distintos. Para saber sobre cual estamos Do Ea|: =T
trabajando hay que asegurarse de que lo tenemos activado | eatar~| > | #]-] To 2 T
(aparece en negrita). Si queremos cambiar de un mapa a otro _;; Ted
. , £# Localizador QEEapIpE
tenemos que activar el Data Frame (Boton derecho sobre el Data | % & samotunssen
Frame% ACtlvate) = ;rrios .
=
= Municipios ca
= Picture.
O MADRID H30.TIF = —
Object.
=g New Data Frame|
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2 £ Localizador
= BarrioGuindalera
|
= Barrios
=
=] Municipios

]
[0 MADRID_H30.TIF

'\'I; Add Data...
‘9 New Group Layer
Copy
¥ Remove
o &F Localizador
=) BarrioGuindalera
|
=l Barrios
I:l Reference Scale »
P Municipios
[ Labeling »
O MADRID_H30.TIF
£F Mapa
Properties...

e Activamos el Data Frame "Mapa”
e Arrastramos la capa de nuestro barrio al Data Frame S5 Locaionior

=] BarrioGuindalera

“"Mapa” (con esto haremos una copia virtual de esa capa, -
e .y . y . g B Barrios
podemos utilizar distinta simbologia para distintos Data o
Municipios
Frames) e

[0 MADRID_H30.img

oE =] Mapal
= BarrioGuindalera
u

Vamos a descargar una nueva capa del IGN, que utilizaremos como base topografica
de nuestro mapa.

e Seleccionamos el mapa que queramos que aparezca de fondo, en este caso la
Ortofoto PNOA de la hoja 559 (Madrid). Continuamos y nos debe salir un
listado en el que elejimos el formato .ecw , pulsamos el boton descargar.

Busqueda Avanzada

Bisqueda Avanzada
Seleccione Productos Seleccione Division administrativa: Seleccione Hoja del MTHS0:
2 = 5!
Ortofoto PNOA Maxima Actualidad | Division administrativa [+] =]
. Ver cuadricula del MTNS0
Wer descripcion de los productos
pagina 1 de 1
Producto Archivo Formato Tamaiio{MB) Descargarz

Ortofoto PNOA Maxima Actualidad PNOA_MA_OF_ETRS88_HU30_h50_0559.ecw ECW 701,08



Si descargamos la capa en nuestra carpeta del ejercicio y la cargamos en el Data
Frame “Mapa” deberia quedarnos algo parecido a esto:

Ebe [dé Yiew Bookmarks Jnaedt Selection Tooks Window belp
D& "
’

Gty b | # v T [Come e e

BT X=ER

fo¥Cl

=
5 B Munsipios

-
# 0 MADRID Haimg

SRR R E JeEH

- 5 Mapa
5 B Baio

“EFnEor
)| W

a

e Cambiamos la simbologia de la capa del barrio para que sea transparente por
dentro y mantenga una linea de contorno roja de 4 puntos de grosor. Para
ello haremos doble click en la capa de nuestro barrio (o0 boton derecho>
Properties) y en la pestafnia Simbology modificamos de la siguiente manera.

| Symbol Sel "

Category: | Al =l

Green Blue

[ |:| Fill Color: _"I

Outline Width: n
S Hollow 400 23

Outfine Color: ll
B O

Leke Rose

Propeties. :
More Symbols -l B
I:‘ I:‘ Save Reset i
Beige Yellow i —

Crear capas nuevas

Vamos a crear una NUEVA CAPA que editaremos para hacer un poligono en una
parcela dentro del barrio seleccionado.

e Abrimos ArcCatalog si no lo tuviéramos abierto, recordamos que es
conveniente tener abiertos siempre ArcMap y ArcCatalog al mismo tiempo para
efectuar una gestion adecuada de nuestros archivos.
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e File> New (o CTRL+N)-> Shapefile

& ArcCatalog - ArcView - G:\SIG_EJERCICIOS

Spatial Reference

Description:

Create New Shapefile &Ié]
Name: |Parcela
Feature Type: | Polygon ﬂ

Geographic Coordinate System:
Name: GCS_ETRS_1589

Eile Edit View Go Tools Window Help

I ) o

a File Geodatabase
5 Personal Geodatabase

&9 Connect Folder...

¥ Delete <> Layer... 71
Rename Q Group Layer
Drop;he; 2] shapefile... [~ Show Details
ordinates will contain M values. Lsed to store route data.
[~ Coordi il M values. Used d
@ Toolbox [ Coordinates will contain Z values. Used to store 30 data.
Exit dBASE Table
G? EE \ . Address Locator.., 0K Cancel
- :
ol FA ] ¥ML Document L

o Name: Parcela

e Feature Type: Polygon

e Description. Edit..--> Coordinate System-> Import (vamos a importar e/
sistema de coordenadas de la capa barrios, por ejemplo, para que utilice el
ETRS89. También podemos seleccionarlo (Select) como hemos hecho
anteriormente)

Aceptamos y nos aparece en nuestra carpeta la nueva capa “Parcela”, que
posteriormente editaremos ya que no contiene informacién.

@& SIG_cursobasico - ArcMap - ArcView

File Edit View Bookmarks Insert Selection Iools Wi
[ = = i) L & [
Create New Feature

x

Editor ~ o

B & Localizador
= BarrioGuindalera
m]

=] Barrios
=
= Municipios
-
[ MADRID_H30.img

= £ Mapa
= B Parcela

[}
5 B BarrioGuindalera
= B PNOA_MA_OF_ETRSE9_HU30_hS0_0550.ccw

RGB
M Red: Band 1

—
M Blue Band 3 I

é:] ArcCatalog - ArcView - GA\SIG_EJERCICIOS

File Edit View Go Tools Window Help
[N= x| %

B & @O N

Location:  [G:\SIG_EJERCICIOS |
Styleshest:  |FGDC ESRI
|| Contents l Preview | Metadata |
8 Catalog Mame |Type
- C
g C'tCARTOGRAFLA mBarrioGuindalera.;hp Shapefile
" ) mBarrios.shp Shapefile .
5@ C:\Users\CARTOTECA\Desk # MADRID_H30.img Raster Dataset ﬂ SIG_cursobasico - Archiap - £
@ C:\Users\CARTOTECA\Doct =] Municipw_os shp Shapefile
(@ DA = lParcela.shp | Shapefile bl £t Yew Bookmaris ]
- EA 1 PNOA_MA_OF_ETRS89_HU30_h... Raster Dataset
@ FA SIG_cursDbasico.mxd Map Document D G E a E
=N Yo
Editoy = - |
C I "P /a” :
L argaimos la nueva capa rarceia en iyl Stan Editing

nuestro proyecto, en e/ Data Frame "Mapa”

Como la capa esta vacia no aparecera en nuestra
vista.Vamos a editar la capa para poder dibujar.

e £En Tools debemos tener activada Editor Toolbar. EDITOR-> Start Editing
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@ SIG_cursabasico - ArcMap - ArcView

File Edit View Bookmarks Insert Selection Tools Window Help

D& [ie] = + 2108 &0
Editor = || b | £ = Task:l(reateNaerature

j Target: |Parcela ﬂ
E| Create Tasks = 7

Create Mew Feature|

- Modify Tasks

B2 £ Localizador

BarrioGuindal
= ¥ BarrioGuindalers Reshape Feature

= ;mos Cut Polygen Features
Mirror Features
=

Extend/Trim Features
Modify Feature
Calibrate Route Feature
Modify Portion of a Line

= & Municipios

=]
O MADRID_H30.img

= Tepolegy Tasks

= £F Mapa
Modify Edge
]
E M Reshape Edge
E Guindal Auto-Complete Polygon
=] arrioGuindalera | L o r e
Select Features Using a Line
= PNOA_MA_OF_ETR! oot Eeats u n
RGB e e
MERed: Band 1 P Tl
trazo.

. En la opcién Task elegiremos la
opcion “Create New Feature” (para
empezar a dibujar) y en Target es MUY
IMPORTANTE que nos fijemos bien en la
capa, ya que debemos elegir aquella que
queremos editar, en este caso “Parcela”.

. Seleccionamos la 2 -
herramienta Sketch Tool y
empezamos a dibujar el poligono, haciendo
doble click cuando hayamos terminado e/

Quedaria algo parecido a esto. Vamos a pintar otro poligono que va a ser parte de la

misma capa.

Si abrimos la tabla de datos de nuestra nueva capa “Parcela” vemos que tiene dos
campos, el 0y el 1, cada uno correspondiente a uno de los dos poligonos que hemos

dibujado.

——
Attributes of Parcel-

‘“l Shape* | Id
L3
I

=]

Polygon 0
Polygon o

-

o FEditor> Stop Editing> édo you want to save your edits? > Yes
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Anadir campos a la tabla de una capa vectorial

Queremos hacer una nueva columna para anadir datos. Para ello, con la tabla de datos
abierta pinchamos en el menu desplegable de la parte inferior derecha (recordamos
que la edicion de la capa debe estar desactivada)

# Find & Replace...

5 Select By Attributes...

Switch Selection
Select All
" AddEicd..
Tum Al Fields On
¥ Show Field Aliases

4
— Restore Default Column Widths
[1d ]

e ———  sinsand Relates »
= [Polygon | 0] Related Tables »
. £i] Creste Graph
Add Table to Layout
&3 Reload Cache
& Print.

Reports »

Export...

Appearance

Records 1| o[ 0 »|m|  Shows[Al Selected | v

o Seleccionamos Add Field. En Type tenemos varias opciones (podemos
consultar en detalle el significado de cada una aqui)
http://webhelp.esri.com/arcgisserver/9.3/java/index.htm#geodatabases/geodat
a-953061022.htm)

Name: [ |

T e - Short Integer ~ -99 - 99

Long Integer  -99.999 — 99.999

fd Float 0,001- 9.999,99
Double -123.456,78 — 1.23456789
Text Texto (ej. Nombres de calles)
] s Date Fecha/hora (mm/dd/yyyy/
hh:mm:ss)

Tabla 2 Tipos de campos en las tablas de datos. Fuente: ESRI

e Vamos a crear una nueva COLUMNA DE TEXTO (seleccionamos por tanto la
opcion Text del desplegable) a la que denominaremos "Uso”, con una longitud
de 20 caracteres.

I FID Shape * Id Uso
Name Usol ¥ 0[Polygon 0
1 | Polygon
Type Text hd il
Field Properties
[ Lengtn [s0 ] I
$ Cancel Record: 14] 4 1 kn Show: | Al Selected | -

. oo | ul4] 2| Seleced | v

Se ha creado un nuevo campo.



http://webhelp.esri.com/arcgisserver/9.3/java/index.htm#geodatabases/geodata-953061022.htm
http://webhelp.esri.com/arcgisserver/9.3/java/index.htm#geodatabases/geodata-953061022.htm

e Para poder rellenarlo es necesario que activemos la edicion de la capa
(Editor-> Start Editing). Con la tabla abierta y la edicion activa podemos
rellenar la tabla. Por ejemplo vamos a poner que para la parcela con FID 0 (que
es la primera que hemos dibujado) se le vaya a dar el uso "Parque publico”,
y para la parcela con FID 1 el uso "Huerto urbano”

"z Attributes of Parcela

FID | Shape* | Id Uso

Polygon 0 | Pargue piiblico
r 1 | Pobygon Huerto urbano

=

=

Record: ﬂjl—zjﬂ Show: ’T Selected j“l

o Vamos a Editor> Save Edits y Editor> Stop Editing

Crear un nuevo campo en la tabla con valores de areas de los

poligonos

En numerosas ocasiones es necesario conocer el area que ocupa un determinado
espacio. En el caso anterior, hemos dibujado dos poligonos, y mediante una sencilla
operacion con la tabla podemos averiguar el espacio que ocupa cada uno.

e Anhadimos un nuevo campo a la tabla, igual que en el ejercicio anterior
| Add Field ! i@é

Name: P
Tee [T |

Field Properties

[ Precision [o |
| Scale I |

Cancel
e Name: Area Type: Double

& Attributes of Parcel. o) m
W —Fi T _shape= T 1o Uso N
oly 0 publico & Sort Ascending i
0] urbano

1[Polygon |

e Nos situamos sobre el titulo del campo Area y pulsamos boton derecho>
Calculate geometry
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Calculate Geome

Property: \Area -

Coordinate System
" Use coordinate system of the data source:
|Cs: ETRS 1989

i+ Use coordinate system of the data frame:
|PCS: ETRS 1939 UTM Zone 30M

Units: ISquare Meters [sq m] ;I
[T Calculate selected records only
=

e Seleccionamos las unidades (Square Meters, m2)> OK

i| Attributes of Parcela
FID Shape * Id Uso A
0 | Polygon 0 | Pargue plblico 33617 6705
1 | Polygon 0 | Huerto urbano 10001,4242

Remrd:ﬂﬂl—ojﬂ Show: W Selected | jl

Nos calcula el area que ocupan nuestros dos poligonos
Preparar los colores de las capas para la leyenda

Vamos a preparar los colores para que en la presentacion final del mapa creemos una
leyenda con ellos.

e Para eso abrimos las propiedades de la capa y cambiamos los colores. En este
caso se ha puesto color verde a la parcela "Parque publico” y naranja a
"Huerto Urbano”

e Desactivamos la primera opcion (All other values)

Layer Properti

General | Source | Selection | Display  Symbology | Fieds | Defintion Query | Labeis | Joins & Relates | HTML Popup |

Show
> [Draw ies using unique values of one fisld. Impot...
Categories Value Field | ~Color Ramp
ﬁuso lei 1 IOEEE-
- Unique values. many f
: Ma'““i:: symbols n a Symbol | Value [ Label [Court |
Charts <all other valuss> <all other valuss> 0
Multiple Attributes <Heading> Uso
Huerts urana Hueto ubana 1
Parque piblico Parque piblico 1 +

e L]

i uMdNIValues AddValves... | Remove | Remove Al | Advanced - |

Acepter | Cancelar | i
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Preparacion del mapa final- LAYOUT

En la parte inferior izquierda de nuestro mapa aparecen los siguientes botones:

e
[

Hasta ahora hemos estado trabajando utilizando la vista de datos "Data View” —,
que sirve para preparar la informacion geografica y para trabajar con las capas.

e Para preparar el mapa para su presentacion final debemos elegir la opcion

"Layout View”

[ Ry T — r— e BT
File Edit View Bookmarks Insert Selection Tooks Window Help
EET-X) ® > ® [

EINTAr L =2
=] [ T 3 o L e— 0L

R LA A A A L A LA L E L N L LN N LWL NN WL ]

fo¥cl

PEDELE BOEE 5B

LI I B T

= B PHOM_MAA_OF ETRSA_HUN_K50 D559 eco
RGB

fasprereorciit@

W Band
8 Greer: Band 2
W lve: Band 3

[ T T T s s A O IO IO O O O IO

Al utilizar Layout View podemos empezar a editar nuestro mapa y afiadirle elementos
como la leyenda, la escala, la orientacion, los titulos, etc.




NOTA: En la vista Layout tenemos otra barra de herramientas nueva, muy parecida a
la barra de herramientas del Data View. De hecho en Layout View aparecen las dos
barras de herramientas, una controlara el contenido del mapa como en el Data View y
la otra, la de Layout, manejara la ubicacion del mapa en relacién a la hoja de
presentacion final. Es recomendable

practicar utilizando las dos barras de Skl =
herramientas para adquirir soltura y EEEEEEEIEEI IR

no confundir una con otra.

Cambio de orientacion y eleccion del tamano
A la hora de presentar un mapa es esencial saber el tamano final de presentacion ya
que de esto dependera la escala.

Si pulsamos botdn derecho sobre la hoja y seleccionamos Page and Print Setup
podemos elegir la orientacidon (Portrait-> Vertical / Landscape-> Horizontal) asi como el
tamaiio de la hoja (A4, A3, etc) y otros parametros relacionados con la impresora.

Page and Print Setup B | )
Prrter Setup
Name [ HP Laserdet P2050 Series PCLG | Propeties
Status Ready
Type: HP Laserdet P2050 Seres FCLE
Wihere s
Commets:
Paper
Size: M - [ Printer Paper
Source: ‘Seleccitn automatica - {] Prrter Margins
Orertation:  Portait @ Landscape Lol
‘Sample Map Blemerts

Map Page Size s -
¥ Use Priter Paper Seftings B

Page

Page Size that will be used is equal to Printer Paper Size ¥ T
Width 21 Certimeters =
Height 297 Certineters .

Oriertation: (o} g

¥ Show Prirter Margins on Layout | Scale Map Elemerts proportionally to changes in Page Size

s

e Seleccionamos la orientacion horizontal (Landscape) y tamarno A3, por
ejemplo
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@ 565 cunobsica - Archisp - [ S———— .

Ele [t Yiew Bookmasks Jnaem Selection Tock Wndow Hep

DEda B X | o~ | § |[2ars EIFT =F
Bt v| b | # [Create Hew Feature =] [ | D@ Georeferencing ¥ | Layer: [WADRID 1 mg @ 3
@ I U IO U O L IO L O DT L LTS T L PO L A R A A T AN - AT |
a@
i Bw
S
nall
LB ool
- 1
- i"i
L=
3
(]
wB
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Nos aparecen los dos Data Frames (Localizador y Mapa) y los podemos mover por la
pagina para ubicarlos como queramos.

Realizar un cuadro en el localizador gue enlace con el mapa

Si queremos que en el Localizador aparezca un rectangulo que indique la ubicacion de
nuestro mapa final

S . Botdn derecho sobre el mapa del Localizador
| i en Layout-> Properties. Seleccionamos la pestafia
Extent Rectangles y elegimos el Data Frame al que
queramos enlazar, en este caso Mapa. Pulsamos la flecha
de la derecha y seleccionamos Frame. Ahi podemos elegir
2ot poae el color del borde del rectangulo. Elejimos el rojo, para que
se vea bien.

& Add Dats...

B Focus Dats Frame

i

4 Cut Ctrl+X
Copy Curl+C

Data Fi Pr rtic
X Dae e cE— )

1 Gro General | Data Frame | Coordinate System | Mumingtion | Gids | Map Cache |
I Group Annotation Groups BrtertRectandes | frame | Sizeiand Postion
o Y] group You can add ene or more extent rectangles to this data frame. Each rectangle shows.
- the extent of the data in one of the other data frames and automatically updates ff the
Order » extent changes.
‘Show extent rectangle for
MNudge 4 Cther data frames: these data frames
Align r > | |Mapa Frame,
Distribute r >
Shaw Leader
Rotate or Flip » o
Leader Symbol...
< T
% ¥

Cancelar Aplicar




Esto creara un rectangulo con el borde de
nuestro mapa grande para ayudar a localizarlo geograficamente.

Vamos a hacer varios mapas localizadores para ubicar bien nuestra zona de estudio.

e Botodn derecho sobre el Localizador-> Properties> Data Frame.
Seleccionamos la opcidn Fixed Extent (ojo: esto bloqueara que luego se
pueda volver a hacer zoom en el localizador) y elegimos La opcién Outline of
Features: Municipios.

Data Frame Properties 7 0=

Amnotation Groups | Bxtent Rectangles | Feme | Sizeand Posiion |
Genersl  Data Frame | Coordnate System | llumination | Gads IMpCach

- Extent

Data Frame - Fixed Extent [ReR =X

" Automatic

" Fied Scale

|1 167,051 j

1 Fixed Bxtent
Top 4.483242.38784486 m
Left 438095001872059m  Right: 448283, 711403468 m
€ Ouline of Selected Graphicls)
Bottom 4471006564093 m  Advanced. @ B B

" Current Visible Bxtent

{+ Outline of Features

~Clip to Shap
Left
I~ Enable | Specify Shape Border I :

[~ Bxtert Used By Full Exent Cor

% Edent of datain all layers (Defaut)

 Other | Specify Extent [T——

Aceptar | Cancelar | Aplicar

Asi conseguimos que la vista del localizador muestre toda la capa de municipios.

I FO X F

e Podemos copiar el localizador y asi poner varias vistas del mismo, aumentando
la escala. Pulsamos boton derecho sobre el localizador-> Copiar y lo
Pegamos en la hoja
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en la parte de la izquierda que se nos duplica el Data Frame “Localizador”, por tanto
para cada uno podremos modificar las capas de manera independiente.

* Al hacer esta copia vemos

Sobre la copia podemos elegir que nos centre la vista en los barrios, por ejemplo

Touta frame - Fond Etent -

"~ Cusrre Vabie Exert

¥ Outie f Fasires

R B =l [a =l

La escala de nuestro mapa

Para saber a qué escala estamos trabajando debemos mirar en el cuadro de la escala

NOTA: No es la misma escala la que nos aparece en el Data View que cuando pasamos
al Layout. Una cosa es la escala de visualizacion mientras estamos preparando la
informacién geografica y otra la de presentacion final del documento, que es la que
aparece en el Layout.

k “1:?.113 -]

e Podemos redondear la escala, por ejemplo a 1:10.000. Simplemente hay que
escribir 10000 en el cuadro y pulsar Enter.

Automaticamente se cambia la escala. Si queremos que no se nos mueva esa escala
podemos pulsar boton derecho sobre el mapa y en Data Frame seleccionar Fixed
Scale.
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Para que aparezca la escala en nuestro mapa debemos insertarla:

o Insert> Scale bar o Scale text (segun queramos que aparezca escala
grafica 0 numérica, respectivamente)

Insert Selection Tool:
£# Data Frame

fg Litle

A Text

= Meatline...

] Legend...

] Morth Arrow...

T

@ Scale Texd...

[£] Picture...

Object.. La escala grafica (Scale Bar) nos permite seleccionar el nUmero de
divisiones, la unidad, etc.

e £n Properties>Label podemos cambiar la etiqueta (por defecto aparece en
inglés) y poner el texto deseado. En este caso escribimos "Metros”
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Atemating Scale Bar 1

Double Atemating Scale Bar 1

m

Propeties
Mare Styles -
Save.. Resct

| Scale
Auto
Number of divisions =

Atemating Scale Bar 2 h=|
100 ‘ Number of subdivisions i
lﬁlﬂ::ﬂssme - [~ Show one division befors 2810
|| whenresimg.
imom m  m w | [dustdvisonvae <]
Hollow Scale Bar 1 Unis
L Division Units
e — = [
Hollow Scale Bar 2 W Scaleto fit page Label Posttion:

sfter bar A

Label: [Metros Symbol
Gep: | 360t

Scale and Units | Numbers and Marks | Fomnat |

Aceptar ‘ Qancelar‘ Aplicar

Rk

Double Atemating Scale Bar 2 = oK Cancel
e W L ;

0 125 250 500 750 1.000

™ =,  Metros

Podemos ampliar o encoger la barra de escala
para que nos quede un nimero redondo.

e Escala numérica (Scale Text): Nos permite también seleccionar las unidades y
el formato de presentacion (aunque si hemos puesto la escala grafica no es
necesario poner la numérica)

A AN 2000 s e am e
T RS . ¢ ==
sie Text Selector] « R X ! s
Freview | 5cs\eTm\pmg,\
1:1.000.000 T Prevew
Posolute Scale

1 centimeter = 10.000 meters 1:1.000.000

Tem =10 km

style
Centimeters = Klometers =

@ Absolute (example: 1:24,000)
1 centimeter =10.000 meters (" Relative (example: 1inch equals 200 mies)

Centimeters = Meters
Format

Tinch =83.333 feet

Inches = Fest Centimeters centimeter
1in =16 miles

Meters meters

Inches = Mies [V Scaleto fit page
Distance:

1inch =27.778 yards % Number Format...
nches = Yards More Siyles -| Separator:
1 page unit = 0,22 map units s Reset [

Relative Soale

Cancelar | Pplcar

0 125 250 500 750 1.000
o™ e ™ e = e [T

La Leyenda
Para preparar la leyenda del mapa debemos insertarla:

e Insert> Legend...

Nos aparece un cuadro en el que podemos elegir los campos que queramos que
aparezcan en nuestra leyenda y el orden (se puede modificar con las flechas arriba y
abajo).

e Vamos a dejar seleccionadas la del limite del barrio y la capa Parcela.
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Choose which layers you wart to include in your legend
Insert Selection Tools Map Layers: Legend kems
: - Parcela SN GaricGuindalera
£# Data Frame i+ BamioGuindslera L] =2 7|
- i PNOA_MA_OF_ETRSE9_HUZ >
g Title
A Text 3
E9 Neatline... <
4 n L <<
fe]| Legend... i R e 3
l North Arrow.. Set the number of columns nyourlegend: [T =]
== Scale Bar...
i Scale Text.. Preview
Picture...
ij ect... Siguierte > Cancelar

caris [ Sguee Cacs

En este cuadro podemos elegir el Titulo de la leyenda y las
opciones de fuente. También se puede dejar en blanco. En el siguiente cuadro
podemos elegir si queremos que tenga borde o no.

Podemos ir modificando los datos que queramos del disefio de nuestra leyenda

Si la vista final no nos convence podemos modificar en cualquier momento la leyenda,
o bien en las propiedades de la capa,o bien cada elemento.

- Vamos a desactivar de la capa Parcela el color que aparece, para que soélo aparezcan
los usos. Hacemos doble click sobre la capa “Parcela” y en Layer Properties
desactivamos la opcién “All other values”

[Layer Properties (S ]
General | Source | Selection | Display  Symbology | Fields | Defintion Guery | Labels | Joins & Relates | HTML Popup |
Shy
ks Draw categories using unique values of one field. Import
Value Fieid Calor Ramp
[Uso =l e IR -|
. ;E "® [ Symbol | Value [ibel [Court | |
Charts | <all other values > <all other values>
Mltiple Attributes <Heading> Uso
Huerto urbano Huerto urbano ? |
Parque piblico Parque pblics 2 J
A J |
ER 0
‘ I I
Add Al Values | Add Values. ‘ Remove Al ‘ Advanced -‘ 1
Cancelar Aplicar ‘

También podemos cambiar aqui el nombre de cada campo Yy titulo.

Si cambiamos sobre la capa el nhombre de la misma tambien veremos los cambios en la
leyenda.

e Por ejemplo al nombre del barrio lo cambiamos por "Limite Barrio ...” y
eliminamos la palabra "Parcela” (situamos el cursor sobre el nombre de la
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capa y lo borramos), y al nombre del campo Uso lo renombramos por "Uso
propuesto’, del mismo modo.

Nos deberia quedar una leyenda mas o menos asi:

LEYENDA

D Limite Barrio Guindalera

Uso propuesto

Huerto urbano

I:l Parque pliblico

NOTA: También podemos cambiar los elementos de la leyenda para personalizarlos
completamente. Habria que pulsar botén derecho sobre la misma->Ungroup y repetir
esta operacidon con cada elemento. De este modo podremos desvincular la leyenda de
nuestra capa y tratarla como si de un texto cualquiera se tratase.

Rosa de los vientos

Es importante que incluyamos una rosa de los vientos en nuestro mapa para indicar el
norte.

e Para ello pulsamos Insert> North Arrow , y elegimos la que queramos.

North Arrow Selector I S|
| Preview
N N - ~ |

+ AL+

ESRINoth1  ESRINoth2  ESRINath3
N N
W‘é} . i \
5 N
ESRINoth4  ESRINoth5  ESRINath
N = N
%< % I Scaletofit page
b y Propetties.
: ! [ E==
ESRINoth7  ESRINoth®  ESRINath e .
N
Save Resst
N cos

Otros elementos: Podemos afiadir Texto para crear titulos, cuadros para hacer
distintos marcos (con la barra de herramientas Drawing) y muchos otros elementos.

Drawing * R O~ A~ (6] Avial >0~ B 7 U AY Dy Sy =~

Introduciendo alguno de estos elementos podremos finalizar nuestro mapa, quedaria
algo asi:




MAPA DE PROPUESTA
DE USO i
DEL DESCAMPADO
"EL PARRAL"

LEYENDA i
D Limite Barrio Guindalera
Uso propuesto :
[j Huerto urbano
|:| Parque publico

B| | Fusnt=: Elaboracion propia a parfir de catogafia
del IGNy de la Comunidad de Madrid

125 250

A 1:10.000

Exportar el mapa final a otros formatos
Si queremos entregar el mapa utilizando un formato distinto al .mxd podemos hacerlo
de la siguiente manera:

e File> Export Map

[ ENENNSNEITSS, En este cuadro podremos elegir la ubicacion para

L

General | Fomat |
Resoluion:

Widh

Heiht

- Bibliotecas
Stios recientes g Carpeta de sistema
- Grupo endf hogar
Escuio QY Covei desitemo
= Servidor
Biliotecas % Carpeta de sistema
Ry e
Equipo O C;ipeta de sistema
ca .
w x
Red Ry o e e
W e L
Nombre:  [SIG_cursobasico = [ G
=2 ‘JPEG j Cancelar |
# Options

™ Cip Output to Graphics Extent

guardar el archivo, el formato (JPEG, PDF, TIFF,
PNG, etc.) y la resolucidn (se recomienda 300 dpi si
el mapa va a ser impreso en impresora o plotter)
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